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 HEC‑HMS and Hydrologic Modeling

ENVI 512

February 2003
I. Hydrologic and Hydraulic Models

Representation of flooding is accomplished using two types of models: hydrologic and hydraulic. Hydrologic modeling simulates the hydrologic response (flow) of a basin to a given input of rainfall. HEC‑1 and HEC‑HMS are two types of hydrologic models. Hydraulic modeling simulates the hydraulic response (water surface profiles) of a stream to a given input of flows. HEC‑2 and HEC‑RAS are both hydraulic models. Both hydrologic and hydraulic models are needed for an in-depth flood analysis of any watershed system. While this exercise will only deal with using HEC‑HMS for hydrologic modeling, a brief description of the four previously mentioned models are given below:

A.  HEC‑1 

The HEC-1 Flood Hydrograph package calculates discharge hydrographs for a given rainfall event. According to the U.S. Army Corps of Engineers, “The HEC‑1 model is designed to simulate the surface runoff response of a river basin to precipitation by representing the basin as an interconnected system of hydrologic and hydraulic components. …Representation of a component requires a set of parameters which specify the particular characteristics of the component and mathematical relations which describe the physical processes. The result of the modeling process is the computation of streamflow hydrographs at desired locations in the river basin.” Thus for computer modeling purposes, HEC‑1 divides the watershed into subwatersheds and reaches. Each subwatershed and reach uses averaged values over the area or stream length for the mathematical coefficients for the hydrologic and hydraulic computations. For this reason, HEC‑1 is referred to as a “lumped-parameter” model.

B. HEC‑HMS

The U.S. Army Corps of Engineers Hydrologic Modeling System (HEC‑HMS) is the Windows-based hydrologic model that supersedes HEC‑1 and contains many improvements over its predecessor. The most notable difference is an easy-to-use graphical user interface (GUI) shown in 

Figure 1 which allows for the easy manipulation of hydrologic elements such as basin and river reaches and the easy input of basin characteristics. The GUI also allows for the easy viewing of results at any point in the model schematic, as shown in Figure 2. In the future, the model should have the capability to model gridded rainfall, such as NEXRAD-estimated rainfall.
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Figure 1: HEC-HMS User Interface
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Figure 2: Graphical Output from HEC-HMS

Another difference between HEC‑HMS and HEC‑1 is the organization of the components that make up each hydrologic modeling run. In HEC‑HMS, a project is created which contains separate “models”: the Basin Model, the Precipitation Model, and the Control Model. The user may specify different data sets for each model and then the hydrologic simulation is completed by using of data set for the Basin Model, the Precipitation Model, and the Control Model. The Basin Model contains the basin and routing parameters of the model, as well as connectivity data for the basin. The Precipitation Model contains the rainfall data, either historical or hypothetical, for the model. The Control Model contains all the timing information for the model, including model time steps and start and stops date and times of the simulation. This allows for easier organization of modeling data than in HEC‑1, which required a separate data set describing all aspects of the modeling run for each independent modeling run.

C. HEC‑2

The HEC‑2 Water Surface Profile program computes one-dimensional water surface profiles for steady flow in a stream with a given channel geometry. The program uses a backwater calculation to determine water surface levels starting from the given starting water surface elevation at the outlet at each profile based on peak flow, roughness (Manning’s) coefficients, cross-sectional geometry, bridges, culverts, and stream length. Like HEC‑1, the program is a DOS-based program.

D. HEC‑RAS

HEC‑RAS is the next-generation hydraulic model which supercedes HEC‑2. Like HEC‑HMS, HEC‑RAS features an easy to use GUI, and the ability to take advantage of HEC‑DSS. Future versions of HEC-RAS will be able to model unsteady flow.

E. Other Modeling Tools

There are a number of tools that assist in the hydrologic and hydraulic modeling process. HEC-DSS and Visual DSS Basics 97 are presented below.

1. HEC‑DSS

A major difference between HEC‑HMS and HEC‑1 is the use of the Data Storage System, or HEC‑DSS, to manage time-series and tabular data. The system was the result of a need in hydrologic engineering to relate similar types of data. Previously, data from one format would need to be entered into another format by hand by each user. Each program would then use separate functions to analyze and graph the data. The HEC‑DSS software is the result of an effort to make hydrologic data management more efficient and allow for the HEC family of programs to use the same database.

What this entails is that time-series and tabular data are not stored in the HEC‑HMS dataset; rather, the data are stored in a separate HEC‑DSS data file, which is accessed by the HEC‑HMS model. The database consists of six parts: the A Part, B Part, C Part, D Part, E Part, and F Part. The data are stored under a unique pathname, which includes all of the parts: /A Part/B Part/C Part/D Part/ E Part/F Part. Using these parts, it is easy for the user and the model to query and manage the data, especially between models.

Table 1: HEC-DSS Part Names

	Part
	Description

	A Part
	River basin or project name

	B Part
	Location of gage identifier

	C Part
	Data type (e.g. flow, rainfall, etc.)

	D Part
	Starting date

	E Part
	Time interval of data

	F part
	User defined descriptor of data


Long-term data series (years and greater) can be stored in HEC‑DSS and multiple model runs can be made in  different times within the data series. The data can also be accessed by other HEC models, such as HEC‑FDA, which analyzes the cost-benefit of flood control and floodplain management alternatives.

2. Visual DSS Basics 97

While the HEC‑DSS software package is an improved means of managing hydrologic data, there is not an easy method to transfer the data from a spreadsheet to a HEC‑DSS file. A Microsoft Excel Add-In produced by Saracino-Kirby, Inc. titled Visual DSS Basics 97 allows the user to easily store regular time-series data from Excel into a HEC‑DSS data-set. Visual DSS Basics 97 also allows for retrieval of data from the HEC‑DSS database, which allows for the easy graphing of results in Excel with minimal user formatting.

II. Hydrologic Modeling and Parameter Estimation

A. Unit Hydrograph Methods (Runoff Transformations)

There are numerous methods of modeling runoff transformations for each subwatershed. We will present two of the more common methods, the Clark (TC + R) Unit Hydrograph and the Snyder Unit Hydrograph. Further discussion on both methods is presented in Hoggan (1997) and Bedient and Huber (1992).

1. Clark (TC + R) Unit Hydrograph

Need:

· Time of Concentration (Tc): Hours

· Storage Coefficient (R): Hours

Both the Brays Bayou and White Oak Bayou models use the Clark TC + R method for unit hydrograph computations. In theory, the Clark method uses a conceptual model consisting of a linear channel, which flows into a linear reservoir. Tc is the time of concentration, which can be measured in a gages basin as the time from the end of a burst of rainfall to its inflection point on the receding limb, normally measured in hours. Tc should also be the travel time from the most remote location in the watershed to the outlet. R, the storage coefficient, usually expressed in hours, can be estimated by taking the flow at the inflection point of the receding limb of the hydrograph and dividing it by the slope of the recession at the same flow. Figure 3 shows how to calculate the coefficients for Tc and R, based on an observed hydrograph.

Bedient and Huber (1992) present the equations for the determination of Tc and R:
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, where

C=4295[% development]-0.678[% conveyance]-0.967, if % development > 18;

C=7.25 if % development is ≤ 18.
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Figure 3: Calculation of Tc and R from an Observed Hydrograph
(adapted from Hoggan 1997)
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, where C’ is taken from:

	S0 (ft/mi)
	% development
	C’

	> 40
	0
	5.12

	20 < S0 ≤ 40
	0
	3.79

	≤ 20
	0
	2.46

	> 40
	100
	1.95

	≤ 20
	100
	0.94
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, where

	L
	=
	length of channel (outflow to basin boundary) (mi)

	Lca
	=
	length along channel to centroid of area (mi)

	S
	=
	channel slope (ft/mi)

	S0
	=
	representative overland slope (ft/mi)

	% development
	=
	percent of land that is developed (%)

	% conveyance
	=
	ratio of flow to overland flow (%)

	Tc
	=
	time of concentration (hr)

	R
	=
	storage constant (hr)


Of these coefficients, determination of Lca is often the most confusing. To determine this coefficient, find the centroid of the subwatershed and draw the shortest line to the stream (say, point A). The distance from point A to the outlet along the length of the stream is Lca.

2. Synder Unit Hydrograph

Need:

· Snyder’s Standard Lag (Tp): Hours

· Snyder’s Storage Coefficient (Cp)

The Snyder method does not define a complete unit hydrograph, so the hydrologic model (HEC‑1 or HEC‑HMS) completes the hydrograph using a trial and error procedure. With the given input parameters, Tp and Cp, the program uses hydrologic model to determine the optimal Clark parameters based on the Snyder coefficients. Bedient and Huber (1992) present equations to determine Tp and Cp:
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, where

	Tp
	=
	Snyder’s standard lag (hr)

	L
	=
	length of channel (outflow to basin boundary) (mi)

	Lc
	=
	length along channel to centroid of area (mi)

	Ct
	=
	coefficient usually ranging from 1.8 to 2.2 (Ct has been found to vary from 0.4 in mountainous regions to 8.0 along the Gulf of Mexico)


Cp is the storage coefficient that normally ranges from 0.4 to 0.8, where larger values of Cp are associated with smaller values of Ct. Cp can also be estimated in the peak flow from the unit hydrograph is known:
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, where

	Qp
	=
	peak discharge of unit hydrograph (cfs)

	A
	=
	drainage area (mi2)


B. Stream Routing

There are numerous methods of modeling stream routing for each stream segment in a hydrologic model. We will present two of the more common methods, Modified Puls (Storage-Outflow) Routing and Muskingum Routing. Further discussion on both methods is presented in Hoggan (1997) and Bedient and Huber (1992).

1. Modified Puls (Storage-Outflow) Routing

Need:

· Storage: ac-ft vs. Outlflow: ft3/s

· Time Steps (or subreaches)

Stream routing for the majority of the reaches in the Brays Bayou and White Oak Bayou watersheds is accomplished using the Modified Puls Method, or storage-outflow routing. The basis behind the Modified Puls Method is that the outflow in the channel is a unique function of storage in the channel. Calculation of the storage outflow relationship often involves a simple hydraulic computation of each river reach using a program such as HEC‑RAS or HEC‑2. A table of corresponding storage and outflows is then entered into the model at each river reach.

Figure 4 shows how the relationship of storage and outflow is determined. The flow, Q, is a function of the water surface elevation, WS. The total storage, S, is then the simple geometric calculation of the volume of water between river segments A and B, and below the WS. Therefore, flow is a function of storage and these relationships are entered in the hydrologic model.
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Figure 4: Modified Puls Stream Routing (adapted from Hoggan 1997)

Major complexities are determining the accurate storage in each reach. Often, idealized geometries for the model need to be assumed and simple open channel flow or more complex hydraulic analysis using HEC‑2 or HEC‑RAS can be used to determine the associated flow.

The number of time steps is the time it takes a drop of water to travel the entire length of the routing reach divided by the computation time of the hydrologic model. To estimate the time it take a drop of water to travel the length of the reach, a hydraulic model should be used. As a rule of thumb, water in a stream can travel 2 mi/hr, although in channelized streams, the rate can increase to 10 mi/hr, or even greater, depending on overland slope and channel roughness.

2. Muskingum Routing

Need:

· Muskingum K (Travel Time): hr

· Muskingum X (Storage Routing)

· Time Steps (or subreaches)

Muskingum K is the travel time for the reach, and is determined by dividing the mean velocity by the reach length. Velocity can be determined from a hydraulic model, such as HEC‑2 or HEC‑RAS, or performing a simple open-channel flow calculation using Manning’s equation. Channel velocities can also be assumed, using the rule-of-thumb presented in the previous section.

Muskingum X is the only means represent storage for the routing step using this routing procedure. Muskingum X ranges from 0 to 0.5, where 0.5 is used for smooth uniform channels with a pure translation of the flood wave. A value of 0.2 is generally used for natural streams and a value of 0.45 is used for most improved urban channels.

The number of time steps is the time it takes a drop of water to travel the entire length of the routing reach divided by the computation time of the hydrologic model. To estimate the time it take a drop of water to travel the length of the reach, a hydraulic model should be used. As a rule of thumb, water in a stream can travel 2 mi/hr, although in channelized streams, the rate can increase to 10 mi/hr, or even greater, depending on overland slope and channel roughness.

Figure 5 shows the effect of Muskingum K and X coefficients on the routed hydrographs. 
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Figure 5: Muskingum Routing

C. Diversions

Diversions for hydrologic models use a simple table relating river flow to diverted flow. These relationships can be determined using geometric calculations and hydraulic models.

D. Loss Rates

The loss rate used in Harris County and many other communities is the simple Initial-Constant Loss Method. Under this method, an initial amount of rainfall is “lost,” or infiltrates (or evaporates) and a constant rate of rainfall is lost per hour. For Harris County, these rates range from 0.5 to 1.0 inches of initial loss, and 0.05 to 0.15 inches per hour of constant loss, depending of degree of urbanization and soil type (Table 2)

Table 2: HCFCD Recommended Losses

	
	Sandy Soils
	Clay Soils

	Losses
	Rural
	Urban
	Rural
	Urban

	Initial (in)
	1.00
	0.75
	1.00
	0.50

	Constant (in/hr)
	0.15
	0.10
	0.10
	0.05


E. Baseflow

The baseflow method used in HEC‑1 is an exponential decay function of a defined starting baseflow according to the following equation:
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where Qo is the starting baseflow, x is the empirical ratio between the recession baseflow and the recession baseflow one hour later (always greater than 1.0), and nt is the number of time steps. In simple hydrologic models over short time periods, baseflow can be neglected.

III. Example Problem

This example problem, will hopefully show the application of both unit hydrograph transformation methods and both routing methods. This problem is adapted from the U.S. Army Corps of Engineering HEC‑HMS User Manual (Chapter 9). The user manual is available free of charge, as is the model, from their web-site http://www.hec.usace.army.mil. This exercise will address the Castro Valley watershed, a small basin located in northern California, and its response to a rainfall event in 1973.

A. Background information

The Castro Valley example problem uses a small watershed, consisting of four subbasins and two stream reaches which will be modeled as routing steps (Figure 6). Following is a description of all the data necessary to setup HMS for this watershed, and a list of commands needed to do the setup. 

B. HEC‑HMS Model Set-Up (Getting Started)

This exercise will recreate a HEC‑HMS model from scratch for the Castro Valley watershed in northern California. 

· Open HEC‑HMS program by double-clicking on the HMS icon.

· To create a new project, select New in the pop-up window. Name the project Castro Example and type Castro Valley urban study for the description. All information will be, by default, stored in the folder in the C:\hmsproj\Castro Example folder.  Click OK.

· To set the defaults for the new project and the desired unit system, select Project Attributes from the File menu. Select English units, Initial/Constant loss rate, Clark UH, and Muskingum routing, and then click OK to save the defaults.

C. Gage Data

There are three ways to enter gage (precipitation and flow data) into the HEC‑HMS model. The first way is to directly enter the data. The second way is to import the data from an existing DSS file. The last way is to import the data from Excel using Visual DSS Basics 97.

· To enter gage data by the user, select Precipitation gages under the Data menu. The first time you use this, a new gage will automatically be created. For additional gages, you will choose Add Gage from the Edit menu. Enter Fire Dept. under Gage ID, and make sure that Incremental Precipitation and Inches are selected in the Data Type and Units windows, respectively. Select Manual Entry and click OK. Enter 16JAN73 and 0300 for starting date and time (January 16, 1973 at 3:00 AM) and enter 16JAN73 and 1000 for ending date and time. Select 10 Minute time interval and click OK. Enter the rainfall at each time step from Table 3 and click OK and Close.

Table 3: Fire Dept. Rainfall on 16JAN73
(Time is end of rainfall total)

	3:10
	0.00
	
	4:20
	0.03
	
	5:30
	0.03
	
	6:40
	0.07
	
	7:50
	0.03
	
	9:00
	0.00

	3:20
	0.00
	
	4:30
	0.02
	
	5:40
	0.09
	
	6:50
	0.07
	
	8:00
	0.01
	
	9:10
	0.01

	3:30
	0.01
	
	4:40
	0.05
	
	5:50
	0.08
	
	7:00
	0.02
	
	8:10
	0.03
	
	9:20
	0.06

	3:40
	0.01
	
	4:50
	0.05
	
	6:00
	0.03
	
	7:10
	0.04
	
	8:20
	0.02
	
	9:30
	0.02

	3:50
	0.08
	
	5:00
	0.02
	
	6:10
	0.04
	
	7:20
	0.03
	
	8:30
	0.01
	
	9:40
	0.04

	4:00
	0.03
	
	5:10
	0.05
	
	6:20
	0.03
	
	7:30
	0.02
	
	8:40
	0.03
	
	9:50
	0.01

	4:10
	0.05
	
	5:20
	0.04
	
	6:30
	0.07
	
	7:40
	0.03
	
	8:50
	0.01
	
	10:00
	0.00


· OPTIONAL: To see how Visual DSS Basics 97 works, close down HEC‑HMS. We have to do this because to programs cannot access the same DSS file at the same time. Open up Excel, and click I Agree for the Visual DSS Basics 97 dialog box. In Excel, click Open… under the Visual DSS Basics 97 File menu (which should be below the File menu for Excel or in a separate dialog box. Explore to the hmsproj file, open the Castro2 folder, double-click on Castro2.dss file, and click OK. This now allows access to the DSS dataset. In the Visual DSS Basics 97 menu, click Retrieve and then Regular Time Series and By Selection…. Click on Full and click OK. If your DSS dataset has become too large, you may narrow the search using different qualifiers for the different parts using the Selective search. Under Time Window, enter the starting date time for the series (January 16, 1973 at 3000) and the ending data and time (January 16, 1973 at 1000). Scroll down until you find the DSS file for the Fire Dept. gage, which should be at something like: /CASTRO VALLEY/FIRE DEPT./PRECIP-INC/16JAN73/10MIN/OBS/. Highlight the DSS pathname and click OK. You can make any changes to the data that you wish inside of Excel, or import new data and change the name of the gage in Part B. To store the new data, simply highlight from the lower right hand corner of the data to Part A: and click on Store and then Regular Time Series. At the dialog box, click OK and the new data should be stored in the DSS file. Close the DSS file by clicking File on the Visual DSS Basics 97 menu and Close. You can save the worksheet if you, for easy import later into HEC‑HMS. DSS files imported into the DSS database using Visual DSS Basics 97 needed to have a gage identified with the DSS file. To do this, in the main menu of HEC‑HMS, click on Edit – Gage Data – Precipitation. In the pop-up menu, click on Add Gage and give the gage a name in the Gage ID field. Click on External DSS File and click OK. In the next pop-up menu, click on Generate Catalog (again, you can limit your query by using the different parts). Find the gage and highlight its pathname and click OK and Close.

· The final way to input gage data into the HEC‑HMS model is to retrieve data from an existing DSS dataset. We will do this for the observed flow at the outlet of the watershed. Select Data – Discharge Gage. The first time you use this, a new gage will automatically be created, after that, you will have to select File – Add Gage for a new gage. Name the gage Outlet and select External DSS Record, then click OK. The DSS file is actually in the existing Castro file, so click on File Browser in the upper right hand corner of the window to select the right DSS file. Explore to the castro folder in the hmsproj folder and open castro.dss. Click on Generate Catalog and highlight the pathname for /CASTRO VALLEY/OUTLET/FLOW/16JAN73/ 10MIN/OBS/, click OK and then Close. You have now imported an existing DSS file from another program into a new dataset.

D. Basin Model

The majority of the hydrologic computations are described in the basin model. We will first describe the existing conditions. At the Project Definition window, select Component – Basin Model – New. Enter Castro 1 for the basin name and Existing conditions for the description and click OK. 
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Map File – HEC‑HMS allows the user to import or define a map file. Click on Basin Model Attributes from the File menu, click the File tab, then click Browse next to Map File window. Explore to the castro folder in the C://hmsproj directory and open castro.map.  Click OK.

· Basin Schematic – HEC‑HMS allows for the easy use and manipulation of hydrologic features. To add a feature, drag the icon from the left hand menu to the place you want it on the schematic. There are four subwatersheds in this model. To add a subwatershed, click and hold the Subbasin icon and drag it to the middle of the delineated watershed. The first will be named subbasin-1, so drag it to the location shown in Figure 6. To edit a subbasin, double click on the icon. If necessary, you can and rename the watersheds so that they match the names from Figure 6 (or you can just drag them around). There are two reaches (routing steps) and these can be added in a similar manner. Again, be sure to match the names and locations of the reaches shown in Figure 6. There are three junctions in the model. Place the junctions and rename them to match the names and locations in Figure 6. To connect East Branch and West Branch with Reach-2 and Reach-1, place each junction over the end of the reach. Each subbasin needs to be connected to either the beginning of a reach or to a junction. To connect the basin to the beginning of the reach (Sub 2 and Sub 4), right click on the subbasin and choose Connect Downstream and then click on the upstream end of the reach. The same method can be used to connect the other two basins to the East and West Branch junctions and can be used to connect both junctions to the outlet. Once all of the connectivity is in place, SAVE the basin model.

All hydrologic components can be edited in two ways. The first is to simply double click on the subbasin icon or reach icon, which allows you to edit the properties of that one subbasin or reach. The second is to select Parameters in the basin model menu, which allows you to edit a limited amount of information for all subbasins that use a particular method. To use this, click on Parameters, and then click on the data type you wish to enter/edit. Coefficients for the remaining Basin Model parameters are either given or calculated below (for instance, subbasin area/baseflow information is in Table 2).  Using the double click method, fill in all of the parmeters, save the basin model and close the SCHEMATIC window.

Subbasin Area/Base Flow Characteristics and Loss Rate Characteristics

Table 4, shown below, gives some background information of different characteristics.  Using the double click method, edit the Loss Rate values.  Select the Initial/Constant method.  Also, edit the Baseflow values, selecting the Recession method.  Note that in the Baseflow menu, you may have to change the units of the Threshold to ratio. 

	
	Loss Rate
	Baseflow/Area

	Subbasin ID
	Initial Loss
	Const. Loss
	Imperv
	Area
	Initial Q
	Recess. Const.
	Thresh

	
	in
	in/hr
	%
	mi2
	cfs/mi2
	
	ratio

	1
	0.02
	0.14
	8
	1.52
	0.54
	0.79
	0.1

	2
	0.02
	0.14
	10
	2.17
	0.54
	0.79
	0.1

	3
	0.02
	0.14
	15
	0.96
	0.54
	0.79
	0.1

	4
	0.02
	0.14
	2
	0.86
	0.54
	0.79
	0.1


Table 4: Castro Valley Subbasin Characteristics

Routing Methods
We will be using two types of routing methods for the example. 

Reach 1 utilizes Muskingum Routing. Again, we can double click on the reach to enter these values. The computation time of the model is 5 min and the average velocity of water in the stream is 0.75 mi/hr. The total reach length is 0.45 miles, and it is a natural stream. So, since it is a natural channel, we’ll assume that X = 0.2. K is equal to length of the reach, divided by the total velocity, or 0.45 mi/0.75 mph, which yields a travel time (K) of 0.6 hours. 0.6 hours is about 36 minutes, which would give about 7 five-minute subreaches.

Reach 2 utilizes the Modified Puls Routing method. We must use the ‘double-click’ method  Again, the average velocity was determined to be about 0.75 mi/hr, but the length of this reach is 0.25 mi. The travel time equals 0.25 mi/0.75 mph, or 0.33 hr, which is about 20 min. There are 4 subreaches, calculated by dividing the travel time (20 min) by the computation time. HEC‑RAS was used to determine the storage outflow relationship shown below in Table 5. This relationship can also be derived using an idealized channel and Manning’s equation.

Table 5: Storage - Outflow Relationship for Reach 2

	Storage (ac-ft)
	0
	0.2
	0.5
	0.8
	1
	1.5
	2.7
	4.5
	750
	5000

	Outflow (cfs)
	0
	2
	10
	20
	30
	50
	80
	120
	1500
	3000


Transform (Unit Hydrograph Methods)

Subwatersheds 1 and 4 will be modeled using the Clark Unit Hydrograph and Subwatershed 2 and 3 will be modeled using the Snyder Unit Hydrograph. 

We will begin with Subs 2 and 3. Double click on the subbasin and select the Transform tab.  The total length of the flow from the further point in Sub 3 to its outlet is 0.4 mi. The length of the point in the stream closest to the centroid to the outlet of Sub 3 is about 0.15 mi. Ct is determined to be about 0.4 (mountainous region). The length of the longest flow path in Sub 2 is 0.55 mi, and length from the centroid to the outlet is 0.18 mi. Like Sub 3, Ct is 0.4. Cp for both watersheds is 0.16. Based on this information, Tp can be calculated as follows. 

For Sub 2,  Tp  =  0.20. 

For Sub 3, Tp  =  0.17.

Next, we will do Subs 1 and 4. While the given empirical data for Houston for the determination of Tc and R are probably not applicable for northern California, we will use the formulas to demonstrate how Clark parameter estimation for Subs 1 and 4. The values listed in Table  were determined from topographic and land use maps.

Table 6: Land Use and Topographic Data for Subs 1 and 4

	
	Sub 1
	Sub 4

	L (mi)
	0.5
	0.4

	Lca (mi)
	0.3
	0.2

	S (ft/mi)
	20
	25

	S0 (ft/mi)
	5
	6

	% development
	25
	5

	% conveyance
	96
	96


Using these coefficients, the following Tc and R values are calculated: 

For Sub 1, Tc = 0.25 hrs and R = 1.79 hrs.

For Sub 4, Tc = 0.17 hrs and R = 1.85 hrs.

E. Precipitation Model

The precipitation model is where the rainfall from the gages is entered into the model. 

· From the main menu, select Meteorologic Model – New from the Component menu. Enter GageWts for the Precipitation Model name and Thiessen weights; 10-min data for the description and click OK.  Then select User Gage Weighting in the Method drop down menu and click OK. For this area, there are three gages: the Fire Dept. recording gage that we have already entered and two non-recording (storm total) gages. To add the Fire Dept. gage, click on Add Gage: Recording and select Fire Dept. and click Add and Close. To add the two non-recording gages, click on Add Gage- Total Storm. Add Proctor School and Sidney School, with 1.92 in and 1.37 in total-storm rainfall totals, respectively. The Index Precip field is used to adjust for bias in the rain gages, and will not be used in this example. Next, click on the Subbasins List button, and click Add underneath Castro 1. The four subbasins that we entered in the basin model should appear. Finally, click on the Weights tab and enter the Thiessen weights from Table 7 below. If the gage names do not appear in the Gage ID column, click inside the column and choose the appropriate gages for each subbasin (ie you will only use Fire Dept. and Proctor School for Subbasin 1).  Every watershed must have at least one gage that is a recording gage for the Temporal Distribution, even if the Gage weight is set to zero. Enter the Thiessen weights in the Total-storm Gage Weight file and be sure to include the Fire Dept. with a weight of 1.0 under the Temporal Distribution. The weights are shown below in Table 7. 

Table 7: Total-Storm Thiessen Weights

	Subbasin
	1
	2
	3
	4

	Fire Dept.
	.8
	.33
	.8
	0

	Proctor School
	.2
	.33
	
	1

	Sidney School
	
	.33
	.2
	


· NOTE: You don’t have to include the gages you’re not using on a particular subbasin, but if you accidentally do, go to the Edit menu and delete the selected row.

· Save and close the precipitation model. 

F. Control Model

The control model sets the timing parameters, both starting and ending times of the hydrologic computations, as well as the computation steps.

· Select Control Specifications – New from Components on the main menu. Enter Jan73 for the Control Specs name and Storm of January 16, 1973 for the description. Enter 16Jan73 for the Starting and Ending Dates and 0300 (which is 3:00 AM) for the Starting Time and 1255 (which is 12:55 PM) for the Ending Time. Select 5 Minutes for the Time Interval, which means that a hydrologic computation will be made every 5 minutes. Click OK.

E. Running the Model

We now are (hopefully) ready to run the model.

· Open the basin model (Castro 1). Click on Simulate – Run Configuration and select one component from the basin model, the precipitation model and the control model. At this point, there should only be one of each, so highlight Castro 1, GageWts, and Jan73. Keep the name Run 1 in the Run ID box, but type Existing Conditions; 16Jan73 storm. Click Add and Close. To run the model, click on the C button on the top right of the basin model screen.

· To view results, right click on any component and your can see a Graph, a Summary Table, and a Time-Series Table. By adding a new basin model, say with increased urbanization, or a different precipitation model, say of a hypothetical storm or even of another rainfall event, you can easily compare results from the different modeling runs.

· These results can be exported to Excel using Visual DSS Basics 97 in much of the same manner as was described in earlier sections.

IV. Problem Assignment

· Determine the hydrologic effect (peak flow and timing) of increasing the percent development from 25 percent to 45 percent and the percent impervious increases from 8 percent to 30 percent for Subwatershed 1 for Castro Valley. What are the effects at West Junction and at the Outlet compared to the Existing Conditions? To do this, open the existing conditions basin, select “save as” under the File menu, rename it “urbanization,” and then make changes to the subbasin. Use the same rainfall event. Show your new TC & R calculations for Subbasin 1 also.

· What is the hydrologic effect on the Existing Condition if the rainfall at each of the non-recording gages is doubled and the rainfall at the Fire Dept. is increased by 50%. 
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